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1. Introduction
eProof fi les are self-contained PDF documents for viewing on-screen and for printing. They contain all appropriate formatting 
and fonts to ensure correct rendering on-screen and when printing hardcopy. DJS sends eProofs that can be viewed, annotat-
ed, and printed using the free version of Acrobat Reader 7 (or greater). These eProofs are “enabled” with commenting rights, 
therefore they can be modifi ed by using special markup tools in Acrobat Reader that are not normally available unless using 
the Standard or Professional version.
The screen images in this document were captured on a PC running Adobe Acrobat Reader version 8.1.0. Though some of 
the images may differ in appearance from your platform/version, basic functionality remains similar. At the time of this writing, 
Acrobat Reader v9.1 is freely available and can be downloaded from: http://get.adobe.com/reader/

2. Comment & Markup toolbar functionality

A. Show the Comment & Markup toolbar
The Comment & Markup toolbar doesn’t appear by default. Do one of 

 the following:
  • Select View > Toolbars > Comment & Markup.
  • Select Tools > Comment & Markup > Show Comment
    & Markup Toolbar.
  • Click the Review & Comment button in the Task toolbar, and choose
     Show Comment & Markup Toolbar.
 To add or remove tools for this toolbar, right-click the toolbar and select the tool. 
 Or, select Tools > Customize Toolbars.

B. Select a commenting or markup tool
 Do one of the following: 
  • Select a tool from the Comment & Markup toolbar.
  • Select Tools > Comment & Markup > [tool].
 Note: After an initial comment is made, the tool changes back to the Select tool 
 so that the comment can be moved, resized, or edited. (The Pencil, Highlight 
 Text, and Line tools stay selected.)

C. Keep a commenting tool selected
 Multiple comments can be added without reselecting the tool.
 Select the tool to use (but don’t use it yet). 
  • Select View > Toolbars > Properties Bar. 
  • Select Keep Tool Selected. 

Annotating PDFs
ams_annotating_pdfs1.1; April 09, 2009; full release

Choose Tools > Customize Toolbars to remove
unnecessary items from the toolbar

(see Section 7 for suggested toolbar layout)

Ch T l C t i T lb t

A. Sticky Note tool; B. Text Edits tool; C. Stamp tool; D. Highlight Text tool; E. Callout tool; F. Text Box tool; G. Various Object tools; H. Pencil tool

A B C D E F HG

3. The Properties bar
The Properties bar can be used to format text and select options for individual tools.
To view the Properties bar, do one of the following:
 • Choose View > Toolbars > Properties Bar.
 • Right-click the toolbar area; choose Properties Bar.
 • Select [Ctrl-E]
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4. Using the comment and markup tools
To insert, delete, or replace text, use the Text Edits tool. Select the Text Edits tool, then select the text with the cursor (or 
simply position it) and begin typing. A pop-up note will appear based upon the modifi cation (e.g., inserted text, replacement text, 
etc.). Use the Properties bar to format text in pop-up notes. A pop-up note can be minimized by selecting the     button inside it.

A

B

C

D

E

A. Attached fi le; B. Highlighted text; C. Crossed-out (strike-through) text; D. Inserted text; E. Replaced text

5. Inserting symbols or special characters
An ‘insert symbol’ feature is not available for annotations, and copying/pasting symbols or non-keyboard characters from Mi-
crosoft Word does not always work. Use angle brackets < > to indicate these special characters (e.g., <alpha>, <beta>).
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7. Summary of main functions
Insert text - Use Text Edits tool (position cursor and begin typing)
Replace text - Use Text Edits tool (select text and begin typing)
Delete text - Use Text Edits tool (select text and press delete key)
Highlight text - Use Highlight Text tool (select text)
Attach a fi le - Use the Attach a File with Comment tool (select tool, position 
                      cursor and click mouse, select fi le)

Suggested toolbar layout

Use the Comments list to review all changes

8. Reviewing changes
To review all changes, do the following: 
  • Select the Show button on the Comment & Markup toolbar.
  • Select Show Comments List.
   Note: Selecting a correction in the list will highlight the corresponding item in the document, and vice versa.

6. Editing near watermarks and hyperlinked text
eProof documents often contain watermarks and/or hyperlinked text. Selecting characters near these items can be diffi cult us-
ing the mouse alone. To edit an eProof which contains text in these areas, do the following: 
  • Without selecting the watermark or hyperlink, place the cursor near the area for editing.
  • Use the arrow keys to move the cursor beside the text to be edited.
  • Hold down the shift key while simultaneously using arrow keys to select the block of text, if necessary.
  • Insert, replace, or delete text, as needed.
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Major Extratropical Cyclones of the Northwest United States: Historical Review,
Climatology, and Synoptic Environment

CLIFFORD MASS AND BRIGID DOTSON

Department of Atmospheric Sciences, University of Washington, Seattle, Washington

(Manuscript received 3 September 2009, in final form 14 January 2010)

ABSTRACT

The northwest United States is visited frequently by strong midlatitude cyclones that can produce hurricane-

force winds and extensive damage. This article reviews these storms, beginning with a survey of the major

events of the past century. A climatology of strong windstorms is presented for the area from southern Oregon

to northern Washington State and is used to create synoptic composites that show the large-scale evolution

associated with such storms. A recent event, the Hanukkah Eve Storm of December 2006, is described in

detail, with particular attention given to the impact of the bent-back front/trough and temporal changes in

vertical stability and structure. The discussion section examines the general role of the bent-back trough, the

interactions of such storms with terrain, and the applicability of the ‘‘sting jet’’ conceptual model. A con-

ceptual model of the evolution of Northwest windstorm events is presented.

1. Introduction

Although the cool waters of the eastern Pacific pre-

vent tropical cyclones from reaching the shores of the

northwest United States, this region often experiences

powerful midlatitude cyclones, with the strongest pos-

sessing winds comparable to category 2 or 3 hurricanes.

Such cyclones are generally far larger than tropical

storms and the resulting damage is greatly enhanced by

the region’s tall trees. Even though Northwest extra-

tropical cyclones have produced widespread damage and

injury, national media attention has been less than for

their tropical cousins. Only a handful has been described

in the literature (Lynott and Cramer 1966; Reed 1980;

Reed and Albright 1986; Kuo and Reed 1988; Steenburgh

and Mass 1996), and questions remain regarding their

mesoscale and dynamic evolutions, including interactions

with terrain. A review of the National Oceanic and At-

mospheric Administration (NOAA) publication Storm

Data and newspaper accounts suggests a conservative

estimate of damage and loss since 1950 due to cyclone-

based windstorms over Oregon and Washington of 10 to

20 billion (2009) U.S. dollars (USD). Perhaps the richest

resource describing the powerful cyclones that strike the

region is the extensive series of Web pages produced by

Wolf Read (more information available at http://www.

climate.washington.edu/stormking/), which reviews over

50 storms.

The Pacific Northwest is particularly vulnerable to

strong cyclone-based windstorms because of its unique

vegetation, climate, and terrain. The region’s tall trees,

many reaching 30 to 60 m in height, act as ‘‘force multi-

pliers,’’ with much of the damage to buildings and power

lines not associated with direct wind damage, but from

the impact of falling trees. Strong winds, predominantly

during major cyclones, account for 80% of regional tree

mortality, rather than old age or disease (Kirk and Franklin

1992). Heavy precipitation in the autumn, which satu-

rates Northwest soils by mid-November, enhances the

damage potential, since saturated soils lose adhesion

and the ability to hold tree roots. The substantial terrain

of the Northwest produces large spatial gradients in

wind speed, with enhanced ageostrophic flow near and

in major topographic barriers that produces localized

areas of increased damage. The most destructive winds

from major Northwest storms are overwhelmingly from

the south and generally occur when a low center passes

to the northwest or north of a location.

The closest analogs to major Northwest cyclones are

probably the intense, and often rapidly developing, ex-

tratropical cyclones of the North Atlantic that move
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northeastward across the United Kingdom and northern

Europe. Cyclones striking both regions develop over the

eastern portion of a major ocean and thus exhibit the

structural characteristics of oceanic cyclones, as docu-

mented by Shapiro and Keyser (1990). Several of the

European events have been described in the literature,

including the 15–16 October 1987 storm (Lorenc et al.

1988; Burt and Mansfield 1988), the Burns’ Day Storm

of 25 January 1990 (McCallum 1990), the Christmas Eve

Storm of 24 December 1997 (Young and Grahame 1999),

and the series of three storms that struck northern

Europe in December 1999 (Ulbrich et al. 2001). Browning

2004, Browning and Field (2004), and Clark et al. (2005)

present evidence that a limited area of strong winds as-

sociated with evaporative cooling and descent (termed

a sting jet) occurred during the October 1987 storm. As

discussed later, a major difference in the environment for

the landfalling major cyclones of Europe and the north-

western United States is the substantial coastal terrain

of the latter, which contrasts with the lesser coastal to-

pography of the United Kingdom anAU1 d the European

mainland. The importance of the Northwest terrain on

windstorm winds is examined in the discussion section.

This paper documents the climatology of strong Pacific

Northwest cyclones, examines the synoptic environments

in which they develop, describes some intense events with

large societal impacts, considers a well-simulated recent

event (the 2006 Hanukkah Eve storm), and identifies

some outstanding scientific questions regarding their

development and dynamics.

2. Historical review

This section describes the general characteristics and

societal impacts of a collection of strong midlatitude

cyclones that have produced substantial damage and

economic loss over the northwest United States. The se-

lection of these events is based on both objective evidence

(such as surface wind speeds) and subjective information

from newspaper articles, research papers, and weather-

related publications such as NOAA’s Storm Data.

a. 9 January 1880

The first documented cyclone-associated windstorm

of the Northwest occurred on 9 January 1880. Regarded

by the Portland Oregonian as ‘‘the most violent storm . . .

since its occupation by white men,’’ the cyclone swept

through northern Oregon and southern Washington,

toppling thousands of trees, some 2–3 m in diameter.

Two ships off the central Oregon coast reported mini-

mum pressures of 955 hPa as the cyclone passed nearby,

and wind gusts along the coast were estimated at 120 kt

(62 m s21). Sustained winds exceeding 50 kt (26 m s21)

began in Portland during the early afternoon, demolish-

ing or unroofing many buildings, uprooting trees, fell-

ing telegraph wires, and killing one person. Scores of

structures throughout Oregon’s Willamette Valley were

destroyed and hundreds more, including large public

buildings, were damaged.

b. The Olympic Blowdown Storm
of 29 January 1921

The ‘‘Great Olympic Blowdown’’ of 29 January 1921

produced hurricane-force winds along the northern Oregon

and Washington coastlines and an extraordinary loss of

timber on the Olympic Peninsula. Over the southwest

flanks of the Olympic Mountains more than 40% of the

trees were blown down (F F1ig. 1), with at least a 20% loss

along the entire Olympic coastline (Day 1921). As noted

in Ferber and Mass (1990) and discussed later in this

paper, the localization of damaging winds probably re-

sulted from mesoscale pressure perturbations produced

by the Olympics. A Weather Bureau observation at the

North Head lighthouse, on the north side of the mouth

of the Columbia River, indicated a sustained wind of

98 kt (50 m s21), with an estimated maximum gust of

130 kt (68 m s21) before the anemometer was blown

away.1 Although the coastal bluff seaward of North Head

may have accelerated the winds above those occurring

over the nearby Pacific, the extensive loss of timber

around the lighthouse and the adjacent Washington coast

was consistent with a singular event. At Astoria, on the

south side of the Columbia, there was an unofficial report

FIG. 1. Timber loss due to the January 1921 windstorm. Graphic

courtesy of the Olympic Natural Resource Center, University of

Washington (http://www.onrc.washington.edu).

1 Before 1928, winds were measured by the Weather Bureau

with a four-cup brass anemometer, compared to current three-cup

anemometers. Thus, pre-1928 wind speeds are not strictly compa-

rable to those reported for latter storms.
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of 113 kt (58 m s21) gusts, while at Tatoosh Island, lo-

cated at the northwest tip of Washington, the winds

reached 96 kt (49 m s21).

c. 12 October 1962: The Columbus Day Storm

By all accounts, the Columbus Day Storm was the

most damaging windstorm to strike the Pacific North-

west in 150 yrs. It may, in fact, be the most powerful

nontropical storm to affect the continental United States

during the past century. For example, Graham and

Grumm (2007) found that the Columbus Day Storm had

greater synoptic wind and geopotential anomalies than

any other midlatitude cyclone for the period 1948–2006.

An extensive area stretching from northern California

to southern British Columbia experienced hurricane-

force winds, massive tree falls, and widespread power

outages. In Oregon and Washington, 46 died and 317 re-

quired hospitalization. Fifteen billion board feet of timber

were downed, 53 000 homes were damaged, thousands

of utility poles were toppled, and the twin 158-m steel

towers that carried the main power lines of Portland

were crumpled. At the height of the storm approximately

one million homes lost power in the two states, with

damage estimated at a quarter of a billion (1962) USD.

The Columbus Day Storm began east of the Philippines

as a tropical storm, Typhoon Freda, and followed the

passage of a moderate storm the previous day. As it moved

northeastward into the mid-Pacific on 8–10 October, the

storm underwent extratropical transition. Approximately

1900 km west of Los Angeles, the storm abruptly turned

northward and deepened rapidly, reaching its lowest

pressure (roughly 955 hPa) approximately 480 km south-

west of Brookings, Oregon, at around 1400 UTC 12 Oc-

tober 1962 (see F F2ig. 2 for the storm track). Maintaining

its intensity, the cyclone paralleled the coast for the next

12 h, reached the Columbia River outlet at approximately

0000 UTC 13 October with a central pressure of 956 hPa,

and crossed the northwest tip of the Olympic Peninsula

6 h later (F F3ig. 3a). At most locations, the strongest winds

followed the passage of an occluded front that extended

eastward from the storm’s low center.

At the Cape Blanco Loran Station on the southern

Oregon coast, sustained winds reached 130 kt (67 m s21)

with gusts to 179 kt (92 m s21), at the Naselle radar site

in the coastal mountains of southwest Washington gusts

hit 139 kt (72 m s21), and 130-kt gusts (67 m s21, the

instrument maximum) were observed repeatedly at

Oregon’s Mount Hebo Air Force Station on the central

Oregon coast. The winds at these three locations were

undoubtedly enhanced by local terrain features, but

clearly were extraordinary. Away from the coast, winds

gusted 80–110 kt (41–57 m s21) over the Willamette

Valley and the Puget Sound Basin. Strong winds were

also observed over California, with sustained winds of

50–60 kt (26–31 m s21) in the Central Valley and gusts

of 104 kt (54 m s21) at Mt. Tamalpais, just north of San

Francisco.

FIG. 2. Tracks of some major midlatitude cyclones striking the Pacific Northwest.

Fig(s). 2 live 4/C
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FIG. 3. Sea level pressure analyses for (a) the 1962 Columbus Day and (b) 1993 Inauguration Day cyclones. Short-term (3 h) sea level

pressure forecasts for (c) the 2006 Hanukkah Eve storm and (d) the December 2007 coastal storm from the 12-km domain of the

University of Washington regional prediction system. Contour interval is 1 hPa; (a) is from Lynott and Cramer (1966) and (b) is from

Steenburgh and Mass (1996).
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Lynott and Cramer (1966) performed a detailed anal-

ysis of the storm, noting that during the period of stron-

gest winds at the surface nearly geostrophic southerly

flow aloft was oriented in the same direction as the low-

level ageostrophic southerlies that were accelerating down

the north–south-oriented low-level pressure gradient. The

strongest surface winds occurred when stability was re-

duced after passage of the occluded front, thus facilitating

the vertical mixing of higher winds aloft down to the

surface. They also noted that the particular track of the

storm, paralleling the coast from northern California to

Washington State, was particularly conducive to wide-

spread damage (Fig. 2). The storm was poorly forecast,

with no warning the previous day.

d. 13–15 November 1981

A number of major Northwest windstorms have come

in pairs or even triplets during periods of favorable long-

wave structure over the eastern Pacific (specifically, a

long-wave trough), and this period possessed such back-

to-back windstorms, with the first producing the most

serious losses. The initial low center followed course

similar to the Columbus Day Storm except that it tracked

about 140 km farther offshore, with landfall on central

Vancouver Island (Fig. 2). Over the eastern Pacific this

storm intensified at an extraordinary rate, with the pres-

sure dropping by approximately 50 hPa during the 24-h

period ending 0000 UTC 14 November 1981. At its peak

over the eastern Pacific, the storm attained a central pres-

sure of just under 950 hPa, making it one of the deepest

Northwest cyclones of the century; coastal winds exceeded

hurricane strength, with the Coast Guard air station at

North Bend, Oregon, reporting a gust of 104 kt (52 m s21).

Winds over the western Oregon and Washington in-

teriors reached 60–70 kt (30–35 m s21).

Thirteen fatalities were directly related to the No-

vember 1981 storms: five in western Washington and

eight in Oregon. Most were from falling trees, but four

died in Coos Bay, Oregon, during the first storm when

a Coast Guard helicopter crashed while searching for a

fishing vessel that had encountered 9-m waves and 70-kt

(35-m s21) winds. Extensive power outages hit the re-

gion with nearly a million homes in the dark.

Reed and Albright (1986) found that this cyclone was

associated with a shallow frontal wave that amplified

as it moved from the relatively stable environment of a

long-wave ridge to the less stable environment of a long-

wave trough. Both sensible and latent heat fluxes within

and in front of the storm prior to intensification contrib-

uted to the reduced stability. As with all major storms

before 1990, the guidance by National Weather Service

numerical models was unskillful, with the Limited-Area

Fine Mesh (LFM) model 24-h forecasts providing little

hint of intensification. Kuo and Reed (1988) successfully

simulated the 1981 storm using the fourth-generation

Pennsylvania State University–National Center for At-

mospheric Research (PSU–NCAR) Mesoscale Model

(MM AU24), and found that roughly half the intensification

in the control experiment could be ascribed to dry baro-

clinicity and the remainder to latent heat release and its

interactions with the developing system. Their numerical

experiments suggested that poor initialization was the

predominant cause of the problematic operational forecast.

e. 20 January 1993: The Inauguration Day
Windstorm

Probably the third most damaging Northwest storm

during the past 50 years (with the 1962 Columbus Day

Storm being number one and the 2006 Hanukkah Eve

event in second place) struck the region on the inau-

guration day of President Bill Clinton. Winds of over

85 kt (43 m s21) were observed at exposed sites in the

coastal mountains and the Cascades, with speeds exceed-

ing 70 kt (35 m s21) along the coast and in the interior

of western Washington. In Washington State six people

died, approximately 870 000 customers lost power, 79

homes and 4 apartment buildings were destroyed, 581

dwellings sustained major damage, and insured damage

was estimated at 159 million (1993) USD.

The Inauguration Day Storm intensified rapidly in the

day preceding landfall on the northern Washington coast.

At 0000 UTC 20 January, the low-pressure center was

approximately 1000 km east of the northern California

coast with a central sea level pressure of 990 hPa. The

storm then entered a period of rapid intensification, with

the central pressure reaching its lowest value (976 hPa) at

1500 UTC 20 January, when it was located offshore of the

outlet of the Columbia River (Fig. 3b). A secondary

trough of low pressure associated with the storm’s bent-

back occlusion/warm front extended south of the low

center, and within this trough the horizontal pressure

differences and associated winds were very large. During

the next six hours, as the low-pressure center passed west

and north of the Puget Sound area, the secondary trough

moved northeastward across northwest Oregon and

western Washington, bringing hurricane-force winds and

considerable destruction.

Official National Weather Service forecasts were ex-

cellent for this storm, with the skillful predictions reflect-

ing, in part, the substantial improvement in numerical

weather prediction during the previous 10 yrs. Steenburgh

and Mass (1996) investigated the effects of terrain on the

storm winds using the fifth-generation PSU–NCAR Me-

soscale Model (MM AU35). They found that pressure pertur-

bations created by the interaction of the bent-back front

with the Olympic Mountains extended the time period of
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high winds in the Puget Sound area but did not enhance

peak winds.

f. 12 December 1995

Of all the major windstorms to strike the Pacific

Northwest, few were better forecast or studied more in-

tensively than the event of 12 December 1995. Hurricane-

force gusts and substantial damage covered a large area

from San Francisco Bay to southern British Columbia,

leaving five fatalities and over 200 million (1995) USD of

damage in its wake. A number of locations in western

Oregon and Washington experienced their lowest pres-

sure on record as the storm’s low center bottomed out

near 953 hPa off the Washington coast. The storm struck

northern California early in the day, with gusts of 90 kt

(45 m s21) at San Francisco; later along the Oregon coast,

from Cape Blanco to Astoria, winds gusted 85–105 kt

(43–53 m s21), while over the Willamette Valley and

Puget Sound basins gusts approached 80 kt (40 m s21).

Approximately 400 000 homes in Washington, 205 000

customers in Oregon, and 714 000 homes in northern

California lost power during this storm.

A field program called Coastal Observation and Sim-

ulation with Topography Experiment (COAST) was

underway during the December windstorm, and the

NOAA WP-3D aircraft examined storm structure both

offshore and as the system approached the coastal moun-

tains of Oregon and Washington. Flying offshore of the

Oregon coast at around 1300 m, the plane experienced

winds of 85–105 kt (43–53 m s21) in a highly turbulent

environment, with salt spray reaching the plane’s wind-

shield as high as 600 m above the wind-whipped seas

(AU4 N. Bond, personal communication).

g. 14–15 December 2006: The Hanukkah Eve Storm

The most damaging winds since the Columbus Day

Storm of 1962 struck the region on 14–15 December

2006, with winds gusting 80–90 kt (40–45 m s21) along

the Northwest coast, 60–70 kt (30–35 m s21) over the

western lowlands, and 85–105 kt (43–53 m s21) over the

Cascades. Over 1.5 million customers lost power in

western Oregon and Washington, at least 13 individuals

lost their lives, and early estimates of damage ranged

from 500 million to a billion (2006) USD.

The December 2006 storm approached the region as

a 970-hPa low and followed a more westerly trajectory

than typical of major Northwest windstorms, which gen-

erally enter from the south to southwest (Fig. 2). In-

tensifying as it approached the coast, the storm’s central

pressure fell rapidly to approximately 973 hPa just prior

to making landfall along the central coast of Vancouver

Island. As the low-pressure center moved inland over

southern British Columbia, the region of strongest pressure

gradient and winds, associated with the bent-back trough

on its southern flank, moved across western Washington,

bringing widespread wind damage (Fig. 3c).

Over western Washington, the damage associated with

the 2006 storm substantially exceeded those of the 1993

Inauguration Day Storm. Nearly double the customers

lost power than in 1993 and restoration took several

weeks in some neighborhoods. Although the winds in

2006 were comparable to those of 1993, extraordinary wet

antecedent conditions produced saturated soils and poor

root adhesion, which resulted in substantially more tree

loss and subsequent damage.

h. 3–4 December 2007

One of the region’s most unusual, long-lasting, and in-

tense windstorms struck the northern Oregon and south-

ern Washington coastal zones for an extended period on

3–4 December 2007. Two-minute sustained winds of

45–65 kt (23–33 m s21), with gusts as high as 130 kt

(67 m s21), produced extensive tree falls, building dam-

age, and power outages from Lincoln City, on the cen-

tral Oregon coast, to Grays Harbor County of coastal

Washington. The extraordinary winds toppled or snapped

off trees throughout coastal Oregon and Washington,

including extensive swaths of forests (F F4ig. 4). The De-

cember 2007 storm was highly localized: while winds were

blowing at hurricane force over the coastal zone, surface

winds were light to moderate over Puget Sound and the

Willamette Valley.

The December 2007 event was singular in several ways.

First, most major Northwest windstorms are associated

with intense and fast-moving low-pressure centers that

move rapidly northward along the coast, producing strong

winds for only three to six hours. In contrast, the long

period of hurricane-force gusts from this windstorm

was associated with a persistent area of large pressure

gradient, between a deep, slow-moving low offshore and

much higher pressure over the continent that remained

over the northern Oregon/southern Washington coast-

lines for nearly 24 h (Fig. 3d). Second, this storm was

associated with extraordinary rainfall over the coastal

mountains, with some locations in the Chehalis Hills of

southwest Washington receiving 700 mm of rain in little

over a day. In general, few cyclone-based windstorms are

associated with sustained heavy rains and flooding, as

found with this event.

3. Climatology of windstorm events

In this section, a climatology of major cyclone-related

windstorm events is presented using an objective ap-

proach based on surface wind observations. Because

most of the population in the region lives along the

6 M O N T H L Y W E A T H E R R E V I E W VOLUME 00

JOBNAME: MWR 00#0 2010 PAGE: 6 SESS: 8 OUTPUT: Wed Mar 17 21:15:44 2010 Total No. of Pages: 29
/ams/mwr/0/mwr3213

M
on

th
ly

 W
ea

th
er

 R
ev

ie
w

  (
Pr

oo
f O

nl
y)

cliffordmass
Inserted Text
, 2009


cliffordmass
Sticky Note
change made


cliffordmass
Inserted Text
to 

cliffordmass
Cross-Out

cliffordmass
Cross-Out

cliffordmass
Replacement Text
largest

cliffordmass
Cross-Out

cliffordmass
Replacement Text
at

cliffordmass
Cross-Out

cliffordmass
Replacement Text
that

cliffordmass
Inserted Text
,



interior corridor west of the Cascade Mountains and

east of the coastal terrain, this analysis will focus on

identifying and characterizing strong southerly wind

events within that region. The wind climatologies at in-

terior stations (not shown) indicated that although most

had their strongest winds from a southerly direction, some

sites experienced high winds from other directions

because of regional terrain features such as gaps. For

example, Portland, Oregon (PDX), reported a high fre-

quency of strong winds from the east, the result of gap

flow through the Columbia River Gorge (Sharp and Mass

2004). For most stations, the primary or secondary wind

maxima were from a southeasterly to southwesterly di-

rection, and these maxima are associated with the major

cyclones that cross the region. Thus, to isolate cyclone-

related high-wind events, the directions between 1358 and

2258 was used as a directional criterion. To aid in the

identification of regional windstorm characteristics, the

region of interest was split into four subregions (FF5 ig. 5).

An event was identified as a major windstorm if two or

more adjacent stations in a north–south line of 10 sta-

tions (Fig. 5) experienced 35 kt (18 m s21) or greater

sustained southerly winds (the National Weather Service

high-wind warning threshold) in a 24-h period. Using

this criterion, 32 separate events were identified since

1948 (TT1 able 1), all associated with Pacific cyclones. The

largest number of events (18) occurred in the northern-

most division (region 1) and the least (7) over the southern

Oregon section (region 4). We found it interesting that

most of the events in the southern three regions oc-

curred before 1965, in contrast to region 1, where only

22% of the events occurred before that date. Some events

influenced more than one region, particularly the 1962

Columbus Day Storm, which affected all four.

The number of cyclone-related windstorms is greatest

in December (F F6ig. 6). Other major windstorm months

include November, January, and February, with re-

duced, but significant, numbers in October and March.

4. Synoptic composites of Northwest windstorms

An important question deals with the synoptic envi-

ronment associated with major storms and how that

environment differs from climatology. To that end, com-

posites of sea level pressure (SLP), 850-hPa temperature,

and 500-hPa height for the dates of major windstorms

noted above were created using the NCEP–NCAR reanal-

ysis (Kalnay et al. 1996). These data are at 2.58 spatial

resolution and 6-h temporal resolution and are available

from 1948 to the present. A daily climatological mean

is calculated by interpolating monthly means, assuming

they are valid for the midpoint of each month. The com-

posites for each region were calculated for the time of

strongest winds (0 h) and for 24 and 48 hours before

(224, 248 h). In addition, anomalies from climatology

and the areas in which the anomalies differ from the mean

FIG. 4. Extensive areas of forest along the northern Oregon and southern Washington coasts

experienced massive loss of trees during the 3–4 Dec 2007 windstorm. Picture courtesy of Wolf

Read.

Fig(s). 4 live 4/C
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at the 95% and 99% confidence levels were calculated

using a Student’s t-test. In what follows, only the com-

posites for region 2 are shown, the composites for the

other regions are qualitatively similar, but with key

features displaced to the north or south.

Turning to the region 2 sea level pressure composites,

a large area of low pressure dominates the northeastern

Pacific two days before the high winds, with deviations

from climatology approaching 214 hPa (FF7 ig. 7). During

the subsequent 48 h, a trough over the southwestern

portion of the domain rapidly moves northeastward and

amplifies into a closed low, which is found just north of the

region 2 at the time of strongest winds (0 h). The result

is an intense north–south gradient over Washington and

Oregon. There is relatively little SLP variance over the

Northwest at the time of strongest winds, and the signifi-

cance of the key trough/low center exceeds the 99% level.

At 500 hPa, a broad, large-scale trough dominates the

eastern Pacific two days before the strong winds (FF8 ig. 8).

A short-wave trough moves through this long-wave

feature and approaches the Pacific Northwest at the

time of strongest winds. Associated with this trough is

enhanced southwesterly 500-hPa flow over the eastern

Pacific. The deviations from climatology of this trough

exceed 250 m and are significant at the 99% level.

Significant deviations of 850-hPa temperatures from

climatology accompany these windstorms (F F9ig. 9). Two

days before the strongest winds, an east–west zone of

enhanced baroclinicity is found over the subtropical

Pacific between a large cold anomaly over the north Pacific

and a warm anomaly west of southern California. This

cold anomaly, with a magnitude exceeding 68C, moves

toward the Pacific Northwest in association with a short-

wave trough, while a warm anomaly pushes northward to

the east. The significance of the cold anomaly exceeds the

99% level.

5. A recent example: The Hanukkah Eve Storm
of 14–15 December 2006

Since the Hanukkah Eve Storm was extremely well

forecast two days prior to the strongest winds, the MM5

FIG. 5. Regions and associated observing locations used in the climatological analyses of major

windstorms.
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was used to illustrate its synoptic and mesoscale evolu-

tions. The strongest winds struck western Washington

between 0600 and 1200 UTC 15 December 2006 and

simulations initialized at 0000 UTC 14 December and

0000 UTC 15 December are considered.

The 500-hPa geopotential heights from this storm are

reminiscent of the composites, with a broad long-wave

trough over the eastern Pacific and an intense short-wave

trough moving northeastward toward the northwest along

an enhanced jet stream/height gradient (FF10 ig. 10). The 12-h

sea level pressure forecast for 1200 UTC 14 December

shows a large low pressure area (central pressure of

988 hPa) located 600 km west of the Oregon/Washington

border (FF11 ig. 11a). Twelve hours later, the low center had

deepened to 978 hPa and had moved northeastward to

250 km west of the central Washington coast (Fig. 11b).

The strongest pressure gradient was found on the western

side of the low associated with the bent-back warm front.

Switching to the 12-km domain, the 3-h pressure forecast

for 0300 UTC 15 December (Fig. 11c) shows a 974-hPa

low making landfall on central Vancouver Island, and an

intense sea level pressure gradient associated with the bent-

back trough and front to the south of the low. During the

next 6 h, the low center moved northeastward into southern

British Columbia, while the intense pressure gradient

associated with the bent-back trough rotated into western

Washington (Figs. 11d,e).

The simulated 10-m wind speeds and sea level iso-

bars during the hours leading up to landfall are shown

in F F12ig. 12. At 2100 UTC 14 December, when the low

was still offshore, the strongest sustained winds, reaching

45 kt (23 m s21), were associated with the bent-back

front to the northwest of the low center (Fig. 12a). At

this and previous hours there was some suggestion of

FIG. 6. The number of windstorm events influencing at least one of the regions shown in Fig. 5

for the period 1948–2006.

TABLE 1. Major windstorm times based on the four regions shown in Fig. 5. Shown are the times of the strongest observed wind speeds

exceeding 35 kt (18 m s21) at two or more adjacent stations.

Region 1 Region 2 Region 3 Region 4

0400 UTC 10 Feb 1949 1800 UTC 15 Jan 1951 1300 UTC 10 Feb 1949 2200 UTC 13 Jan 1950

0900 UTC 24 Dec 1954 0600 UTC 24 Dec 1954 0300 UTC 27 Nov 1949 1900 UTC 4 Dec 1951

1900 UTC 6 Dec 1955 1300 UTC 28 Feb 1955 1700 UTC 13 Jan 1950 1600 UTC 22 Dec 1955

0800 UTC 13 Oct 1962 1700 UTC 6 Dec 1955 1000 UTC 27 Oct 1950 2000 UTC 24 Feb 1961

2000 UTC 14 Nov 1981 2000 UTC 22 Dec 1955 1500 UTC 15 Jan 1951 0000 UTC 13 Oct 1962

1600 UTC 22 Oct 1982 2200 UTC 29 Jan 1958 2200 UTC 4 Dec 1951 0100 UTC 28 Mar 1963

1527 UTC 20 Jan 1993 1100 UTC 25 Feb 1958 1700 UTC 28 Feb 1955 0500 UTC 14 Nov 1981

0400 UTC 18 Nov 1995 1600 UTC 27 Apr 1962 2100 UTC 29 Jan 1958

0500 UTC 13 Dec 1995 0400 UTC 13 Oct 1962 0700 UTC 25 Feb 1958

0753 UTC 24 Nov 1998 1835 UTC 20 Jan 1993 0400 UTC 17 Dec 1961

1553 UTC 29 Jan 1999 0400 UTC 13 Dec 1995 0300 UTC 13 Oct 1962

2253 UTC 5 Feb 1999 1046 UTC 15 Dec 2006 1800 UTC 5 Feb 1965

1500 UTC 3 Mar 1999 1200 UTC 26 Mar 1971

2353 UTC 16 Jan 2000 1100 UTC 14 Nov 1981

0600 UTC 13 Mar 2003 2300 UTC 12 Dec 1995

2053 UTC 15 Nov 2006
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coastal acceleration along the Oregon coast and to a lesser

degree southeast of the Olympics. Six hours later the low

deepened to 972 hPa and sustained winds in the bent-

back front and trough had increased to over 55 kt

(28 m s21; Fig. 12b). The coastal acceleration has dis-

appeared, and as suggested later, this may be due to the

destabilization of the atmosphere as cooler air moved in

aloft. By 0600 UTC, the strongest winds with the bent-

back front were poised to make landfall as the low center

began crossing central Vancouver Island (Fig. 12c).

Finally, at 0900 UTC, the extraordinary pressure gradient

and winds with the bent-back trough had moved over

western Washington (Fig. 12d). At the same time, the low

center was moving to the north over the British Columbia

mainland.

As noted by Von Ahn et al. (2005, 2006), scatterometer

winds are useful for determining the wind distributions in

intense oceanic cyclones. The QuikSCAT scatterometer

winds at approximately 1400 UTC 14 December 2006

indicate that the strongest sustained winds, reaching

50 kt (26 m s21) or more, were associated with the warm

front to the north of the cyclone and in the bent-back

trough/front to the south of the low center (F F13ig. 13a).

A later view of the storm just before landfall (0400 UTC

15 December) shows the strongest winds [exceeding 50 kt

(26 m s21)] to the south and southwest of the low center

in the bent-back trough (Fig. 13b). Both of these scat-

terometer wind fields are consistent with the model sim-

ulations shown above, and reflect common structures in

strong oceanic midlatitude cyclones.

A frequently observed feature of oceanic cyclones is

an intense, bent-back front whose baroclinicity increases

rapidly with height in the lowest few thousand feet above

the ocean surface, and which weakens in the middle

troposphere. F F14igure 14 shows the simulated 850-hPa

thermal structures, heights, and winds for the storm be-

fore and during landfall. At 0000 UTC 15 December, an

intense warm front is found west and north of the low

center; it weakens south of the low (Fig. 14a). As in

cases documented by Shapiro and Keyser (1990), Neiman

FIG. 7. Sea level pressure composites for major wind events in region 2 (defined in Fig. 5) for 48, 24, and 0 h before the time of strongest

winds over Puget Sound. (left) The composite pressures (hPa) and the standard deviations (hPa; color) among the storms. (middle) The

climatological sea level pressure distribution and the deviations of the composite windstorm pressure from climatology (blue negative, red

positive). (right) The regions where the deviations from climatology are significant at the 95% and 99% levels.

Fig(s). 7 live 4/C
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and Shapiro (1993), and Neiman et al. (1993), the stron-

gest winds are closely aligned with this intense bent-back

baroclinic zone. During the period before the bent-back

trough makes landfall, the intense bent-back tempera-

ture gradient and associated winds rotate around the low

in counterclockwise fashion (Figs. 14b,c). There is also

evidence of a warm-seclusion structure as the cold air

circles the low, a feature noted by Shapiro and Keyser

(1990), Neiman and Shapiro (1993), and Neiman et al.

(1993).

To explore the differences in conditions on the coast

and within the western Washington interior associated

with this storm, FF15 igs. 15 and 1F16 6 present the temporal

evolution of surface parameters at two sites: one 15 km

off the Pacific coast (Destruction Island) and another

over central Puget Sound (West Point lighthouse). At

Destruction Island, the winds increased rapidly and

switched from easterly to southeasterly around 1800 UTC

14 December as the warm front pushed north of that

location (Fig. 15). The approach of the bent-back front

and trough produced continuing pressure falls and the

arrival of the bent-back front resulted in temperatures

falling after 0300 UTC 15 December. As the trough

passed, pressure rose rapidly, winds shifted to north-

westerly and the winds peaked at 62 kt (31 m s21
AU5)

around 0900 UTC 15 December. At West Point, inland

between two main regional barriers (the Olympics and

the Cascades), winds increased considerably later in

the day with warm frontal passage between 2000 UTC

14 December and 0100 UTC 15 December. The winds

during this period, constrained between the two bar-

riers, maintained a southerly (roughly 2008) direction.

The bent-back trough moved through between 0900 and

1000 UTC and was associated with the strongest gusts,

reaching 55 kt (27 m s21), but little change in direction. As

at Destruction Island, the strongest winds occurred during

the period of rapid pressure rises and cold advection, a

characteristic of most Northwest cyclonic windstorms.

A critical element of strong Northwest cyclone events

is the evolution of the shear and stability profiles aloft

prior to and during the strongest winds. As first noted by

Lynott and Cramer (1966), winds accompanying such

FIG. 8. As in Fig. 7, but for 500-hPa geopotential height. (left) The composite heights (m) and the standard deviations (m; color) among

the storms. (middle) The climatological 500-hPa height distribution and the deviations of the composite windstorm heights from cli-

matology (blue negative, red positive). (right) The regions where the deviations are significant at the 95% and 99% levels.

Fig(s). 8 live 4/C
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windstorms often increase rapidly during the transition

to lower stability after passage of occluded or warm

fronts. FF17 igure 17 presents the wind and temperature

aloft over central Puget Sound based on Aircraft Com-

munications Addressing and Reporting System (ACARS)

data during ascents and descents into Seattle Tacoma

and Boeing Field airports as well as surface observa-

tions at Seattle Tacoma Airport during the December

2006 event. Prior to warm/occluded front passage (1800–

2300 UTC 14 December), modest low-level winds were

generally easterly and the lower atmosphere was stably

stratified (nearly isothermal). A large shear in hori-

zontal wind existed between the surface [southeasterly

at ;5–15 kt (;2–7 m s21)] and above approximately

1000 m [over 50 kt (25 m s21)]. The front crossed Puget

Sound at the surface at approximately 0030 UTC 15 De-

cember, with a shift in the surface winds from south-

easterly to southwesterly, a strengthening of the winds

aloft, and a reduction of vertical stability. The back-bent

front/trough started moving in after 0300 UTC, resulting

in cooling and further destabilization aloft. Strong winds

lowered toward the surface up to the time of maximum

wind gusts, near 0800 UTC.

Reflectivity and Doppler wind velocities from the

National Weather Service Camano Island radar (F F18ig. 18;

the radar is located 50 km north of Seattle) illustrates

the changes in wind and precipitation structures in time.

Although the coastal zone is blocked by the Olympic

Mountains, this radar gives a good view down the Strait of

Juan de Fuca and over the interior lowlands. At 1934 UTC

14 December, a few hours prior to the passage of the

surface warm front, moderate to heavy rain had spread

over the region, and an s-shaped configuration of the

zero-Doppler velocity line, characteristic of warm ad-

vection, was evident. Low-level winds near the radar

were from the southeast at 10–30 kt (5–15 m s21). At

0054 UTC 15 December, the warm front was moving

through and precipitation became more showery. A band

of high reflectivity, marking the surface front, was as-

sociated with intense rainfall, approaching 2.5 cm over

an hour at some locations. Extraordinary urban flooding

occurred, causing the drowning death of a Seattle woman

FIG. 9. As in Fig. 7, but for 850-hPa temperature (8C). (left) The composite 850-hPa temperature and the standard deviations (8C; color)

among the storms. (middle) The climatological 850-hPa temperature distribution and the deviations of the composite windstorm tem-

peratures from climatology (blue negative, red positive). (right) The regions where the deviations are significant at the 95% and 99%

levels.

Fig(s). 9 live 4/C
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in her basement. Low-level winds had shifted to south-

erly and increased to 50–60 kt (26–31 m s21); they slowly

increased during the next four h in the postfrontal

showers (0405 UTC). By 0806 UTC, the bent-back trough

had reached the region and the winds had strengthened

further. As the trough moved through the Puget Sound

region, strong westerlies began to push eastward into the

Strait of Juan de Fuca (also evident in the radar by the

tongue of blue color). Convergence at the leading edge of

the westerlies produced an area of greatly enhanced re-

flectivity. Finally, by 0959 UTC, the bent-back trough had

moved sufficiently eastward for strong westerly flow to

push through the Strait into the northern Sound, with the

leading edge of enhanced precipitation approaching the

western Cascade slopes. Westerly winds aloft produced

a north–sound rainshadow east of the Olympics and the

mountains of Vancouver Island.

6. Discussion

The above historical and climatological reviews of

major cyclone-based windstorms affecting the Pacific

Northwest interior reveal some of the essential synoptic

characteristics of these events, while the case study of

the Hanukkah Eve Storm illustrates important meso-

scale features. In this section, mesoscale aspects will be

examined in more detail and some of the major out-

standing questions are discussed.

a. The role of the bent-back trough and front

Simulations and mesoscale analyses of strong, recent

Northwest cyclone/windstorms (e.g., Steenburgh and

Mass 1996) reveal common structural elements, with the

bent-back trough and front being the focus of strongest

winds in most events. In these Northwest cyclones, the

largest temperature gradients above the boundary layer

are in a bent-back front that passes through and south of

the low center. The strongest winds are at low levels

(lowest kilometers) on the cold side of this front, which

extends southward into the bent-back trough south of

the low center. Structurally, this configuration is similar

to those found in oceanic cyclones during major field

programs such as ERIC AU6A and GALE (e.g., Neiman and

Shapiro 1993; Neiman et al. 1993) and is frequently ev-

ident in scatterometer winds over the oceans (Von Ahn

et al. 2005, 2006; Fig. 13). As in the strong maritime

cyclones studied by Neiman and Shapiro (1993) and

Neiman et al. (1993), intense Northwest cyclones often

possess a warm core structure produced by cold air ro-

tating around the low center, and this geometry pro-

duces a reverse vertical shear and weakening of the

winds above the lower troposphere. As noted earlier,

FIG. 10. The 500-hPa heights (dam) and vorticity (1026 s21)

at (a) 1200 UTC 14 Dec, (b) 0000 UTC 15 Dec, and (c) 0600 UTC

15 Dec 2006. Graphics from MM5 with 36-km grid spacing.
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strong oceanic cyclones strike northern Europe and

Great Britain, and the association of strong winds with

the bent-back front and trough is evident both in ob-

servations and in realistic modeling studies (e.g., Burt

and Mansfield 1988; Clark et al. 2005).

b. Interactions of storms with terrain

Unlike the situation in much of continental Europe

and the United Kingdom, major Northwest windstorms

interact with substantial coastal and near-coastal topo-

graphic barriers, with some terrain exceeding 2 km in

vertical extent. Such interactions have the potential to

greatly alter mesoscale pressure and wind distributions,

and thus the impact of these storms. An important issue is

the degree to which low-level storm winds are accelerated

over the coastal waters by terrain, which ranges from

the relatively low, but extensive, coastal mountains of

Oregon to the isolated, but higher, Olympic mountains.

FIG. 11. SLP (hPa) and 925 hPa temperatures (8C, color)

at (a) 1200 UTC 14 Dec, (b) 0000 UTC 15 Dec, (c) 0300 UTC

15 Dec, (d) 0600 UTC 15 Dec, and (e) 0900 UTC 15 Dec 2006.

Isobar contour interval is 1 hPa. (a),(b) From the 36-km domain;

the remainder, 12-km domain.

Fig(s). 11 live 4/C
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Ferber and Mass (1990) showed that strong southerly

or southeasterly winds interacting with the Olympic

Mountains produces an intense pressure gradient on the

southwest side of the mountains between the mesoscale-

pressure ridging to the south of the barrier and pressure

troughing to the north (FF19 ig. 19). This enhanced pressure

gradient often greatly accelerates winds along the cen-

tral coast of the Olympic Peninsula during the initial

periods of major windstorm events when southerly flow

in the lower atmosphere approaches the barrier. Such

topographically enhanced winds may well have con-

tributed to the extensive forest blowdown along the

central Olympic coastline during the severe 1921 storm.

Enhanced winds are also observed over northern Puget

Sound and the eastern Strait of Juan de Fuca during such

periods caused by the hypergradient created by trough-

ing to the lee (north) of the Olympics (also see Fig. 19).

Under extreme situations with very high Froude numbers

of the incoming flow, the lee trough can intensify into a

well-defined mesoscale low with large pressure gradients.

FIG. 12. MM5 10-m wind-speed forecasts (kt) valid at (a) 2100 UTC 14 Dec, (b) 0300 UTC 15 Dec, (c) 0600 UTC 15 Dec, and (d) 0900 UTC

15 Dec 2006. SLP isobars (hPa) are shown in solid lines, 1-hPa contour interval.

Fig(s). 12 live 4/C

MONTH 2010 M A S S A N D D O T S O N 15

JOBNAME: MWR 00#0 2010 PAGE: 15 SESS: 8 OUTPUT: Wed Mar 17 21:17:38 2010 Total No. of Pages: 29
/ams/mwr/0/mwr3213

M
on

th
ly

 W
ea

th
er

 R
ev

ie
w

  (
Pr

oo
f O

nl
y)



FIG. 13. QuikSCAT scatterometer surface winds for approximately (a) 1400 UTC

14 Dec and (b) 0400 UTC 15 Dec 2006. Wind speeds (kt) are color-coded.

Fig(s). 13 live 4/C
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Such a situation occurred during the Hood Canal wind-

storm event of 13 February 1979, when the strong flow

of a synoptic cyclone approaching the coast intersected

the Olympic Mountains, resulting in an intense low

to the northeast of the barrier that accelerated winds

to over 100 kt (51 m s21; Reed 1980). Steenburgh and

Mass (1996) examined the influence of coastal terrain

on the winds associated with the Inauguration Day

Storm of January 1993. Starting with a realistic high-

resolution MMAU7 5 simulation, the coastal terrain was

removed to determine its impact. The results suggested

only minimal terrain enhancement of winds along the

coast during the period of strongest winds, and that

troughing in the lee of the Olympics prolonged the

period of high winds over the northern Puget Sound

area.

Another obvious influence of regional terrain is the

strong ageostrophic winds within and downstream of

gaps and channels in the mountains prior to and during

major cyclone-based windstorm events. As the low cen-

ters move northward or northeastward along the coast,

large east–west pressure gradients can develop across

gaps in the Cascade and coastal mountains, resulting in

strong downgradient flow, either associated with sea level

gaps (such as the Columbia River Gorge or the Strait of

Juan de Fuca) or higher-level gaps or passes, such as

Stampede Gap of the central Washington Cascades, with

the latter associated with hybrid gap/downslope winds

FIG. 14. The 850-hPa temperatures (8C, color shading), geopotential heights (m, black lines), and winds (kt) from a short-range MM5

forecast for (a) 0000 UTC 15 Dec, (b) 0300 UTC 15 Dec, and (c) 0600 UTC 15 Dec 2006.

Fig(s). 14 live 4/C
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(Mass and Albright 1985; Steenburgh and Mass 1996).

Such downslope flow descending Stampede Gap has

produced strong easterly or southeasterly winds reaching

70–120 kt (31–62 m s21) prior to the development of strong

southerly winds that occur as the low center makes

landfall to the north. As a result, some lowland sites

downstream of gaps can experience two wind maxima

associated with cyclone-based windstorms: an easterly

maximum when the low center is immediately offshore

and a southerly peak when the low passes north of the

region.

Strong downgradient ageostrophic flow up the major

north–south ‘‘channels’’ west of the Cascade crest (such

as the Willamette Valley, the Puget Sound basin, and the

Strait of Georgia) is a hallmark of the cyclone-based

windstorms of the region. As described by Overland

(1984), when isobars are parallel to terrain barriers, the

winds can be nearly geostrophic, but when the isobars are

oriented normal to the mountain barrier crests so that

there is a substantial along-barrier pressure gradient, air

tends to accelerate downgradient ageostrophically within

a Rossby radius of deformation of the terrain under stable

conditions. In such situations, the Coriolis force is not an

effective restraint on flow acceleration and the major

balance is between pressure gradient and drag. It is par-

tially for this reason that the greatest wind speeds in the

interior lowlands occur when the low center moves north

of the point in question, since that configuration produces

a large along-barrier pressure gradient and ageostrophic

acceleration at low levels. In addition, when a low center

FIG. 15. Destruction Island, WA, surface observations from 1200 UTC 14 Dec–0000 UTC

16 Dec 2006.

18 M O N T H L Y W E A T H E R R E V I E W VOLUME 00

JOBNAME: MWR 00#0 2010 PAGE: 18 SESS: 8 OUTPUT: Wed Mar 17 21:18:12 2010 Total No. of Pages: 29
/ams/mwr/0/mwr3213

M
on

th
ly

 W
ea

th
er

 R
ev

ie
w

  (
Pr

oo
f O

nl
y)

cliffordmass
Cross-Out

cliffordmass
Inserted Text
 to 


cliffordmass
Cross-Out

cliffordmass
Replacement Text
,

cliffordmass
Inserted Text
, and acceleration.



is northwest of a location, the winds aloft generally have

a southerly component; thus, low-level ageostrophic ac-

celeration to the north is supported by the downward

mixing of southerly momentum from aloft. Furthermore,

when a low center has moved northward, there is gener-

ally lower-tropospheric cold advection and destabilization,

thus enhancing the downward mixing of higher momen-

tum air from above.

Bond et al. (1997) and Bond and Walter (2002) noted

that winds measured at 600–1400 m ASL off central

Oregon by the NOAA WP-3 aircraft during the 12 De-

cember 1995 windstorm did not evince any acceleration

over the coastal waters as the low made landfall to the

north. During that period, the lower troposphere was well

mixed with a high Froude (Fr) number (roughly 3), where

FR 5 U/(hN), U is the incoming flow speed, h is the height

of the terrain, and N is the Brunt–Väisälä frequency. In

contrast, substantial coastal acceleration has been found

when strong flow approaches the much higher terrain

of southeast Alaska and Vancouver Island (Overland

and Bond 1993, 1995; Loescher et al. 2006; Colle et al.

2006; Olson et al. 2007).

Examining simulations of both the 2006 Hanukkah

Eve storm and dozens of landfalling storms during 2008

and 2009, the authors have often noted coastal wind en-

hancement immediately upwind of the Oregon coastal

terrain with landfalling cyclones during periods of greater

lower-tropospheric stability that precedes occluded/warm

front passage. To illustrate this enhancement, F F20ig. 20

shows the near-surface winds every six hours from a

FIG. 16. Surface observations at West Point, WA, from 1200 UTC 14 Dec–0000 UTC

16 Dec 2006.
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realistic MM5 simulation of the 2006 Hanukkah Eve

storm using 4-km grid spacing. During the initial time,

winds north of the warm front (positioned along the

southern Oregon coast) were southeasterly with no ev-

idence of coastal acceleration (1200 UTC; Fig. 20a).

There is a suggestion of coastal enhancement south of

the warm front, where the winds had increased and shifted

to southwesterly. Six hours later (1800 UTC; Fig. 20b), the

warm front had reached the Oregon/Washington border

and coastal acceleration is evident, particularly north of

Cape Blanco, on the southern Oregon coast. At 0000 UTC

coastal enhancement was still apparent along the Oregon

coast, but not along the Washington coast where the

mountains are less continuous (Fig. 20c). During the

next 12 h, as the bent-back trough approached, cooler air

moved in aloft, the vertical stability lessened, the wind

veered to a more westerly direction, and the coastal

enhancement weakened and subsequently disappeared

(Figs. 20d,e).

To better understand the simulated coastal wind en-

hancement, the model soundings during the event at

Salem, Oregon, in the Willamette Valley, are shown in

FF21 ig. 21. The initial sounding at 1200 UTC 14 December,

immediately before surface warm frontal passage at that

location, indicated an unsaturated and stable boundary

layer, with considerable shear between weak southeast-

erlies at low levels and moderate southwesterlies aloft

(Fig. 21a). Six hours later, after warm frontal passage, the

winds were southwesterly through depth, but consider-

able stability and shear remained in the lowest 100 hPa

(Fig. 21b). It is during this time that low-level coastal

speed enhancement became apparent (Fig. 20). Over the

next 12 h, low-level stability slowly decreased as cooler

air spread in aloft (Figs. 21c,d). Simultaneously, coastal

wind enhancements declined, either because of increased

momentum mixing from aloft or lesser coastal blocking

and jet formation. Vertical shear was considerably re-

duced in Salem’s winds during this period. By 1200 UTC

15 December, there was a deep adiabatic layer extending

from just above the surface and little evidence of coastal

wind acceleration (Figs. 21e, 20). In short, when the lower

atmosphere was characterized by onshore flow and con-

siderable stability, coastal wind enhancement was evi-

dent. In contrast, during the period of strongest winds,

a period with considerable destabilization aloft due to

cold air advection, there is little suggestion of coastal wind

enhancement along the Northwest coast. These findings

are consistent with the aircraft observations taken during

the 1995 windstorm (Bond et al. 1997) in which no coastal

enhancement was noted during the latter portion of the

storm as the low made landfall to the north.

Finally, almost all landfalling storms weaken rapidly as

they approach and cross the largest terrain barriers of the

region (the Cascades of Oregon and Washington, and its

extension, the Coast Mountains, of British Columbia).

c. Application of the sting jet conceptual model
to the northwest United States

As noted previously, a number of European researchers

(e.g., Browning 2004; Browning and Field 2004; Clark

FIG. 17. Temperatures (red, 8C) and winds (kt, black) aloft from ACARS aircraft data and surface winds (kt) from

Seattle–Tacoma Airport (blue).
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et al. 2005) have suggested the importance of a sting jet

mechanism in major cyclones in which mesoscale areas of

particularly strong winds are associated with evaporative

cooling and descent. Specifically, they propose that the

most damaging winds emanate from the evaporating tip of

a hooked cloud head on the southern flank of the cyclone,

with evaporative descent bringing high-momentum air

down to the surface. Furthermore, they noted a banded

structure in the hooked cloud field that they suggested was

caused by slantwise convection.

There are reasons to question whether this mecha-

nism is significant in Northwest windstorms. First, away

from terrain there is little evidence for mesoscale lo-

calization of high winds for most large windstorms, a fact

supported by the radar imagery shown for the recent

Hanukkah Eve storm (Fig. 18) and for other events (not

shown). Second, satellite imagery for a collection of

major Northwest windstorm events do not suggest the

cloud geometry noted by Browning (2004) and others

during the period of strongest winds; namely, strong

winds downstream of an evaporating cloud edge (FF22 ig. 22).

Finally, high-resolution simulations of Northwest wind-

storms (e.g., Steenburgh and Mass 1996; the Hanukkah

Eve event shown above) can produce realistic strong

winds without any evidence of sting jet structures and

dynamics. It is, of course, possible that this mechanism

could occur over the Northwest, but at this point, there

is little evidence of its importance.

d. Cyclone central pressure versus wind speed

Central pressure is a useful, but imperfect, measure of

wind speed and damage associated with Northwest mid-

latitude cyclones; the major cyclone-based Northwest

windstorms that produced extensive damage had central

pressures as low as the mid-950s hPa to as high as ap-

proximately 980 hPa. To illustrate, T T2able 2 presents the

central pressures at landfall of the strongest windstorms

striking region 2 (see Fig. 5) since 1958. The greatest

windstorm in terms of the extent and magnitude of strong

winds (the 1962 Columbus Day Storm) possessed a very

low central pressure (956 hPa), but so did strong, but lesser

events (November 1981, December 1995). In contrast,

extremely damaging contemporary storms (January 1993

and December 2006) had considerably higher central

pressures (970s hPa). Clearly, factors other than central

pressure are important: storms vary in size; the sur-

rounding pressure fields differ among storms leading to

different pressure gradients even if the central pressures

are the same; the speed of motion and vertical stability

properties of storms vary, as do storm trajectories with

respect to major terrain barriers. Regarding the envi-

ronment, if unusually high pressure is in place, then a

nearby, but modest low, or a strong one well offshore

can produce strong pressure gradients associated with

extreme winds. This latter situation occurred on 3–4 De-

cember 2007 when the contrast between unusually high

pressure over land and a low-pressure system (ranging

from 955 to 970 hPa) far offshore produced winds ex-

ceeding 100 kt (51 m s21) along the northern Oregon

and Washington coasts for nearly 24 h, in contrast to most

cyclone-based wind events that last 3–9 h as a deep low

quickly passes through the region. Figure 3d shows the

sea level pressure forecast from the MM5 near the height

of the event (27 h, valid at 1500 UTC 3 December 2007).

e. Predictability

Great strides have been made in the prediction of

intense cyclonic windstorms striking the Northwest

United States. Virtually every major storm prior to 1990

was not correctly forecast by the National Weather

Service (NWS) because of the inability of operational

numerical weather prediction systems to correctly ini-

tialize and forecast major cyclones. For example, showers

and light winds were predicted over western Washington

for the day of the great Columbus Day Storm of 1962. For

the 14 November 1981 windstorm, the NWS operational

high-resolution model at that time—the Limited-Area

FIG. 19. Sea level pressure (10XX hPa) and surface winds (kt) at

2100 UTC 5 Mar 1988 from Ferber and Mass (1990).
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FIG. 20. The 10-m winds from a 4-km grid spacing MM5 simulation initialized at 0000 UTC 14 Dec

2006 for forecasts verifying at (a) 1200 UTC 14 Dec, (b) 1800 UTC 14 Dec, (c) 0000 UTC 15 Dec,

(d) 0600 UTC 15 Dec, and (e) 1200 UTC 15 Dec 2006. Simulated SLPs (hPa) are also shown.

Fig(s). 20 live 4/C
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Fine Mesh (LFM) model—only predicted a weak trough,

but the availability of satellite imagery (from a local

television station) gave the NWS a tool for providing

some warning. Kuo and Reed (1988) using the MM4 for

that storm found that improving the initialization with

supplementary data produced a moderate cyclone, albeit

still weaker than observed. In contrast, the 20 January

1993 Inauguration Day Storm and the 12 December

1995 event were well forecast by the Eta Model. Similar

skill was noted for the December 2006 Hanukkah Eve

event using the Global Forecast System (GFS) and North

American Mesoscale (NAM) models.

A clear contributor to more skillful windstorm fore-

casts has been improved initialization over the Pacific

FIG. 21. Model soundings at Salem, OR,

at (a) 1200 UTC 14 Dec, (b) 1800 UTC

14 Dec, (c) 0000 UTC 15 Dec, (d) 0600 UTC

15 Dec, and (e) 1200 UTC 15 Dec 2006.

Simulated winds are also shown.

Fig(s). 21 live 4/C
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because of enhanced observations (mainly from satel-

lites) and better data assimilation. However, significant

forecast failures for major storms still occur. For example,

for the 3 March 1999 windstorm, listed in Table 1 above,

the 48-h forecast of the Eta Model valid 0000 UTC

3 March 1999 predicted a low center that was 24 hPa too

weak and positioned 500 km southeast of the observed

location (McMurdie and Mass 2004). The initialization

of the Eta Model over the Pacific was poor and the

quality control scheme rejected good buoy data. The

48-h forecast from the NCEP Aviation Model (AVN)

was better but still possessed large errors, with the central

pressure of the low center being 13 hPa too weak and

displaced 200 km to the south of the observed position.

Another recent failure was the 8 February 2002 ‘‘Valley

Surprise’’ event, which brought winds gusting to 80 kt

(41 m s21) in the southern Willamette Valley without

any warning from the U.S. forecast models (McMurdie

FIG. 22. Satellite imagery of four major Northwest windstorms at the time of maximum winds over western Washington. The 0900 UTC

15 Dec 2006 (a) infrared and (b) water vapor Geostationary Operational Environmental Satellite (GOES) imagery. Infrared imagery at

(c) 1330 UTC 3 Mar 1999 and (d) 1800 UTC 20 Jan 1993.

TABLE 2. Central pressure at landfall of major windstorms for

region 2 over the past 50 years AU10.

Landfall date Pressure

24 Feb 1958 978 hPa

12 Oct 1962 956 hPa

14 Nov 1981 956 hPa

20 Jan 1993 976 hPa

12 Dec 1995 954 hPa

15 Dec 2006 970 hPa
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and Mass 2004). For the 2002 event, there was a sub-

stantial variability in skill among major forecast centers,

with the Met Office model producing the most skillful

prediction.

f. A conceptual model of Northwest wind events

Most major northwest windstorm events caused by

strong midlatitude cyclones can be divided into four

stages (FF23 ig. 23). In this schematic evolution, we consider

a wind event over western Washington, but the ideas are

appropriate for most areas west of the Cascade crest by

shifting the features north or south. As noted above, the

vast majority of such storms move to the northeast as

they approach and make landfall.

In the prefrontal stage, the low center is well offshore

and a warm front or warm occlusion extends westward

south of the area of interest (Fig. 23a). Isobars are ori-

ented roughly north–south, cool air is in place over

the region at low levels, and winds are light (generally

southeasterly). Strong winds are often observed at the

exits of gaps in the regional mountains and extensive

precipitation has spread over the region at this time.

With frontal passage (Fig. 23b), low-level winds accel-

erate substantially and temperatures rise, with the ori-

entation of the isobars shifting to be less parallel to the

north–south terrain. Thus, there is an increased pressure

variation along the regional terrain barriers (which are

generally oriented north–south) and an increase in the

southerly ageostrophic wind component. After frontal

passage, precipitation becomes lighter and more showery

in character, with vertical stability considerably lessened,

allowing more effective mixing of southerly momentum

down to the surface. This downward momentum mixing

is enhanced by the increasing southerly and southwest-

erly winds aloft as the low center approaches. Winds at

this stage often gust to 20–40 kt (10–21 m s21) and some

initial damage may be reported. The most damaging pe-

riod of windstorm events occurs as the bent-back trough

south of the low center rotates into the region (Fig. 23c).

Winds can increase to 40–100 kt (20–51 m s21), with the

strongest gusts limited to a period of 3 to 6 h. as the bent-

back trough and associated low center move to the north-

east, the winds shift to westerly or northwesterly aloft and

winds weaken substantially (Fig. 23d). One exception is

in the Strait of Juan de Fuca, where the passage of the low

produces a large along-gap pressure gradient that often

results in a westerly surge with winds reaching 30–60 kt

(15–30 m s21).

g. Some remaining questions

Significant issues remain regarding the dynamics, evo-

lution, and modeling of Northwest windstorm events.

Many of the strongest storms are associated with large-

magnitude isallobaric pressure couplets, characterized by

strong pressure falls prior to the cyclone and even larger

post-low pressure rises. The strongest surface winds are

generally during the periods of large pressure rises. Are

isallobaric wind accelerations (Gill 2003) important,

considering the already highly ageostrophic nature of the

low-level winds in this mountainous region? Another

issue is the relative importance at lower elevations of

downward mixing of geostrophic momentum aloft com-

pared to ageostrophic, downgradient acceleration. Clearly,

the strongest windstorms had both factors contributing,

but to what degree can either alone produce powerful

damaging winds at the surface? A frequently observed

deficiency of model simulations of major events, even at

very high resolution, are excessively geostrophic winds

near the surface; the origin of this problem, possibly be-

cause of deficiencies in planetary boundary layer pa-

rameterizations, such as excessive vertical mixing in the

lower troposphere during stable conditions, needs to be

identified and fixed. Further examination is needed for

the relationship of major storms and the phase of the

El Niño–Southern Oscillation (ENSO); initial results

from a study of the eight largest cyclonic windstorms

since 1880 suggests that the most significant events gen-

erally occur in neutral ENSO years (Mass 2008).

7. Summary and conclusions

Landfalling oceanic extratropical cyclones can bring

strong, damaging winds to the Pacific Northwest that are

comparable to those associated with hurricanes. North-

west windstorms are most frequent from November

through February; since 1948 there have been 32 events

that have brought sustained and spatially extensive winds

greater than 35 kt (18 m s21) to the western Oregon and

Washington interiors, with many more events along the

coast. Roughly once a decade, a storm brings hurricane-

force winds to the Puget Sound lowlands or the Willamette

Valley, while on the coast this is usually a yearly event.

It is interesting that the frequency during the past 60 yrs

of major cyclonic windstorm events appears to have

decreased over northern California and Oregon, while

increasing over Washington State.

The strongest winds generally occur when a deep

northeastward-moving low center passes north of a lo-

cation. Major windstorms of the region are generally

associated with central pressures ranging from 955 to

980 hPa, although major wind events over limited areas

have accompanied storms with higher pressures (980–

995 hPa). Strong Northwest cyclones have resulted in

tens of billions in USD of damage and the loss of several

hundred lives during the past 60 years; the Columbus
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Day Storm of 12 October 1962 was the most powerful

Pacific cyclone to strike the region over the past 150 yrs,

and was perhaps the most power midlatitude cyclone to

affect the United States in a century. The predictability

of these events has improved dramatically; prior to 1990

few were accurately forecast a day ahead, while since

that time, most storms have been well predicted by op-

erational numerical models.

The synoptic evolution associated with the major

storms is generally characterized by an extensive long-

wave trough over the eastern Pacific, in which an em-

bedded short-wave trough initiates a major development

as it moves into the downstream (eastern) side of the long-

wave trough. For western Washington, the most intense

events are associated with intense lows moving across the

northwest Olympic peninsula or the lower portion of

FIG. 23. Typical stages of a Northwest cyclone-based windstorm. Sea level isobars (hPa), 925 hPa temperatures (8C, shading), and 10-m

winds (kt) are shown. Sea level isobar contour interval is 1 hPa.

Fig(s). 23 live 4/C
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Vancouver Island, while for Oregon events the low crosses

Washington State.

The structure of most major landfalling storms re-

sembles the midlatitude ocean cyclones described by

Shapiro and Keyser (1990) and others. A bent-back

occlusion or warm front is evident and the strongest

pressure gradients and winds are associated with the

bent-back trough south of the low center. As the low

approaches the coast, the winds are generally light and

southeasterly in the cool, stable air north of the associ-

ated warm or warm-occluded front. After frontal pas-

sage, the winds accelerate rapidly as the isobars change

orientation, creating an along-barrier pressure gradient

and ageostrophic acceleration to the north. Further-

more, the lessening of stability after frontal passage fa-

cilitates the downward mixing of momentum. Winds

then increase further as the intense pressure gradients of

the bent-back trough moves in and the influx of cooler

air aloft lessens vertical stability.

Coastal acceleration with such major cyclones appears

limited to the early period of relatively high stability and

onshore flow; as cooler air moves in aloft with the bent-

back trough and vertical stability declines, near-shore

wind enhancement declines. Northwest windstorms ap-

pear to have structural and synoptic similarities to the

intense storms that make landfall on England and France;

however, there is little evidence to date of the sting jet

phenomenon, whereby mesoscale areas of enhanced

wind and damage are associated with evaporatively cooled

downdrafts. Central pressure is a useful but imperfect,

measure of wind speed and damage associated with

Northwest midlatitude cyclones; the major cyclone-based

Northwest windstorms that produced extensive dam-

age had central pressures as low as the mid-950s hPa to

as high as approximately 980 hPa. Significant ques-

tions about Northwest windstorms remain, including

the significance of isallobaric effects, the importance of

vertical stability variations, and the excessively geo-

strophic nature of storm winds in current mesoscale

models.

Acknowledgments. This work has been supported by

in part by the National Science Foundation under Grant

ATM-0504028. This work has benefited immensely by

the interactions with Wolf Read, the consummate

Northwest authority on windstorm climatology, dam-

age, and wind distributions. His windstorm web pages

are an invaluable resource for the community (more

information at http://climate.washington.edu/stormking/).

The paper has been greatly improved by the comments

and suggestions of Ted Buehner, Wolf Read, and Mark

Albright.

REFERENCES

Bond, N. A., and Coauthors, 1997: The Coastal Observation and

Simulation with Topography (COAST) experiment. Bull.

Amer. Meteor. Soc., 78, 1941–1955.

——, and B. A. Walter, 2002: Research aircraft observations of the

mean and turbulent structure of a low-level jet accompanying

a strong storm. J. Appl. Meteor., 41, 1210–1224.

Braun, S. A., R. A. Houze, and B. F. Smull, 1997: Airborne dual-

Doppler observations of an intense frontal system ap-

proaching the Pacific Northwest coast. Mon. Wea. Rev., 125,

3131–3156 AU8.

Browning, K. A., 2004: The sting at the end of the tail: Damaging

winds associated with extratropical cyclones. Quart. J. Roy.

Meteor. Soc., 130, 375–399.

Browning, K., and M. Field, 2004: Evidence from Meteosat imag-

ery of the interaction of sting jets with the boundary layer.

Meteor. Appl., 11, 277–289.

Burt, S. D., and D. A. Mansfield, 1988: The great storm of 15-16

October 1987. Weather, 43, 90–114.

Clark, P., K. Browning, and C. Wang, 2005: The sting at the end of

the tail: model diagnostics of fine-scale three-dimensional

structure of the cloud head. Quart. J. Roy. Meteor. Soc., 131,

2263–2292.

Colle, B. A., K. A. Loescher, G. S. Young, and N. S. Winstead,

2006: Climatology of barrier jets along the Alaskan coast.

Part II: Large-scale and sounding composites. Mon. Wea.

Rev., 134, 454–477.

Day, P. C., 1921: Details of the weather of the United States: Severe

storms. Mon. Wea. Rev., 49, 37.

Ferber, G. K., and C. F. Mass, 1990: Surface pressure perturbations

produced by an isolated mesoscale topographic barrier. Part II:

Influence on regional circulations. Mon. Wea. Rev., 118,

2597–2606.

Gill, A. E., 2003: Atmosphere Ocean Dynamics. Academic Press,

662 pp.

Graham, R. A., and R. Grumm, 2007: Utilizing standardized

anomalies to assess synoptic-scale weather events in the

western U.S. Preprints, 22nd Conf. on Weather Analysis and

Forecasting/18th Conference on Numerical Weather Prediction,

Park City, Utah, Amer. Meteor. Soc., paper 16B.3.

Kalnay, E., and Coauthors, 1996: The NCEP/NCAR 40-year re-

analysis project. Bull. Amer. Meteor. Soc., 77, 437–471.

Kirk, R., and J. Franklin, 1992: The Olympic Rain Forest. Uni-

versity of Washington Press, 128 pp.

Kuo, Y. H., and R. J. Reed, 1988: Numerical simulation of an ex-

plosively deepening cyclone in the eastern Pacific. Mon. Wea.

Rev., 116, 2081–2105.

Loescher, K. A., G. S. Young, B. A. Colle, and N. S. Winstead,

2006: Climatology of barrier jets along the Alaskan coast.

Part I: Spatial and temporal distributions. Mon. Wea. Rev.,

134, 437–453.

Lorenc, A. C., R. S. Bell, T. Davies, and G. J. Shutts, 1988: Nu-

merical forecast studies of the October 1987 storm over

southern England. Meteor. Mag., 117, 118–130.

Lynott, R. E., and O. P. Cramer, 1966: Detailed analysis of 1962

Columbus Day windstorm in Oregon and Washington. Mon.

Wea. Rev., 94, 105–117.

Mass, C., 2008: The Weather of the Pacific Northwest. University of

Washington Press, 280 pp.

——, and M. Albright, 1985: A severe windstorm in the lee of the

Cascade Mountains of Washington State. Mon. Wea. Rev.,

113, 1261–1281.

28 M O N T H L Y W E A T H E R R E V I E W VOLUME 00

JOBNAME: MWR 00#0 2010 PAGE: 28 SESS: 8 OUTPUT: Wed Mar 17 21:19:16 2010 Total No. of Pages: 29
/ams/mwr/0/mwr3213

M
on

th
ly

 W
ea

th
er

 R
ev

ie
w

  (
Pr

oo
f O

nl
y)

cliffordmass
Cross-Out

cliffordmass
Sticky Note
removed


cliffordmass
Cross-Out

cliffordmass
Cross-Out

cliffordmass
Replacement Text
research


cliffordmass
Cross-Out

cliffordmass
Inserted Text
generally 

cliffordmass
Cross-Out

cliffordmass
Replacement Text
largest

cliffordmass
Cross-Out

cliffordmass
Inserted Text
further

cliffordmass
Cross-Out



McCallum, E., 1990: The Burns’ Day storm, 25 January 1990.

Weather, 45, 166–173.

McMurdie, L., and C. Mass, 2004: Major numerical forecast fail-

ures over the northeast Pacific. Wea. Forecasting, 19, 338–356.

Neiman, P. J., and M. Shapiro, 1993: The life cycle of an extra-

tropical marine cyclone. Part I: Frontal-cyclone evolution

and thermodynamic air–sea interaction. Mon. Wea. Rev.,

121, 2153–2176.

——, ——, and L. Fedor, 1993: The life cycle of an extratropical

marine cyclone. Part II: Mesoscale structure and diagnostics.

Mon. Wea. Rev., 121, 2177–2199.

Olson, J. B., B. A. Colle, N. A. Bond, and N. Winstead, 2007: A

comparison of two coastal barrier jet events along the south-

east Alaskan coast during the SARJET field experiment. Mon.

Wea. Rev., 135, 3642–3663.

Overland, J. E., 1984: Scale analysis of marine winds in Straits and

along mountainous coasts. Mon. Wea. Rev., 112, 2530–2534.

——, and N. A. Bond, 1993: The influence of coastal orography:

The Yakutat storm. Mon. Wea. Rev., 121, 1388.

——, and ——, 1995: Observations and scale analysis of coastal

jets. Mon. Wea. Rev., 123, 2934–2941.

Reed, R. J., 1980: Destructive winds caused by an orographically

induced mesoscale cyclone. Bull. Amer. Meteor. Soc., 61,
1346–1355.

——, and M. D. Albright, 1986: A case study of explosive cyclo-

genesis in the eastern Pacific. Mon. Wea. Rev., 114, 2297–2319.

Shapiro, M. A., and D. Keyser, 1990: Fronts, jet streams, and the

tropopause. Extratropical Cyclones, The Erik Palmén Me-

morial Volume, C. W. Newton and E. O. Holopainen, Eds.,

Amer. Meteor. Soc., 167–191.

Sharp, J., and C. F. Mass, 2004: Columbia Gorge Gap winds: Their

climatological influence and synoptic evolution. Wea. Fore-

casting, 19, 970–992.

Souder, M. O., 1934: Severe local storms, October 1934. Mon. Wea.

Rev., 62, 394–396 AU9.

Steenburgh, W. J., and C. F. Mass, 1996: Interaction of an intense

extratropical cyclone with coastal orography. Mon. Wea. Rev.,

124, 1329–1352.

Ulbrich, U., A. Fink, M. Klawa, and J. Pinto, 2001: Three extreme

storms over Europe in December 1999. Weather, 56, 70–80.

Von Ahn, J. M., J. M. Sienkiewicz, and G. Mcfadden, 2005: Hurri-

cane force extratropical cyclones observed using QuikSCAT.

Mar. Wea. Log, 49, 34–39.

——, ——, and P. S. Chang, 2006: The operational impact of

QuikSCAT winds at the NOAA Ocean Prediction Center.

Wea. Forecasting, 21, 523–539.

Young, M. V., and N. S. Grahame, 1999: Forecasting the Christmas

Eve storm of 1997. Weather, 54, 382–391.

MONTH 2010 M A S S A N D D O T S O N 29

JOBNAME: MWR 00#0 2010 PAGE: 29 SESS: 8 OUTPUT: Wed Mar 17 21:19:17 2010 Total No. of Pages: 29
/ams/mwr/0/mwr3213

M
on

th
ly

 W
ea

th
er

 R
ev

ie
w

  (
Pr

oo
f O

nl
y)

cliffordmass
Cross-Out

cliffordmass
Sticky Note
removed





